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1.1.  About Data Crow 

 
There are many programs that claim to have a nice database to put your music in, and 
there are other programs that allow you to store your audio CD information, but Data 
Crow has it all under one roof! 
 
Data Crow helps you organize your software, music, book, and movie collections by 
using online databases from Amazon, IMDb, and freedb, as well as the tag information 
stored within your files.  
 
We think you will find Data Crow easy to use and a great all-rounder! 
 
  
 
For information or support, you can contact us here: 
 
Information:  info@datacrow.net 
Support:     support@datacrow.net 
Website: http://www.datacrow.net 
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1.2. Starting the application 

By default Data Crow uses an internal database named “dc”. For whatever reason, an 
additional database can be created. To do this, start Data Crow with the database name 
as a parameter: 
 

Java –jar datacrow.jar <database name> or 
datacrow.exe <database name> 

 
By default, Data Crow uses the previously used database. 
 
Note: in older versions it was possible to use a database server. This not 
supported as of version 2.0.   
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2. Main window 

The main window contains a menu bar, toolbar, module list, status bar, and a pane 
where new and existing items can be viewed. 
 
 

Menu bar 

The menu bar provides access to all the functionality available for the currently active 
module. 

 

 
 

(See Menu bar for detailed information about the menu bar.) 

 

 

Tool bar 

The tool bar provides shortcuts to all the same functionality as the menu bar. You 
can disable the text labels by right-clicking on the toolbar and selecting “Show 
labels”. 

 
(See Toolbar for detailed information about the menu bar.) 

 

  
Module list 

The module list shows the modules you can work with. You can switch between 
modules at any time (even during imports). The active module is highlighted. 
 

 
 

(See Modules for detailed information about the menu bar.) 
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<Item> tab 

(Note that “<Item>” can represent a software, movie, music, book, or CD item, 
depending on the module that is currently active.) 

 
Existing items can be displayed in this pane and updated or deleted. Search results 
are also displayed here. 

 

 
 

 

New <item> tab  

Add new items to the database. New items can be imported from the internet or 
extracted from files or CD drives. 
 

 
 
 

Block note 

Write annotations, remarks, or reminders. The contents are automatically saved. 
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Quick View 

The quick view shows detailed information on the currently selected item 
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3. Menu bar 

There are four main menus: Files, Settings, Tools, and Information. 
 

File 

 
 

Items can be created, deleted, or opened. You can also view events or quit the 
application. 

 
 
Settings 

 
 

Display and input settings can be changed. The module list, as well as other parts of 
the UI, can be made visible or hidden. 
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Tools 

 
 

The tools available here depend on the module that is active. Some tools, such as 
“Item import”, are common to all modules 

 
 

Information 

 
 

Contains a link to the About dialog and to the internal Help system. 
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4. Toolbar 

 

 
 

Item Wizard 
Opens the wizard for creating a new item. 
 
New 
Opens the form for a new item. The new item can be saved after the information 
has been filled in. 
 
Open 
Opens the selected item. 
 
Save 
Saves the selected item. 
 
Save all 
Saves all new or modified items. 
 
Remove / Delete 
Removes a new item (not yet saved) or deletes an existing item. 
 
Find 
Opens the Find dialog where you can define search conditions. 
 
Find Again 
Searches using the conditions specified in the last search. 

  
 Settings 
 Opens the settings dialog. 
 
 Report 
 Opens the reporting dialog 
 

Import 
Opens the import dialog where you can import data from CD or hard disk. 
 
Online Search 
Searches the online databases of Amazon, IMDb, and freedb. 
 
Event Log 
Shows system events. 
 
Help 
Opens the Help system. 
 
About 
Displays information about Data Crow. 
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5. Modules  

You can organize your software, music, movie, and book files by using the 
corresponding Data Crow modules. The following modules are available:  
 
 

Data Crow modules 

Module  Supported file formats Online updates File parsing 

Software All Yes (Amazon) No 

Movies DivX, XviD, MPEG Yes (IMDb) Yes 

Music Files OGG, FLAC, MP3, MP4, 
WAV, APE, ASF, MPC 

No Yes 

Audio CDs All Yes (freedb) No 

Books N/A Yes (Amazon) No 
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6. Settings  

The Settings menu allows you to change the general behavior of the application. For 
example, display options (such as the background color), or data input options (such as 
required fields) can be found here.  
 
These settings are stored in the “datacrow.properties” file in the Data Crow directory of 
your installation.  
 

6.1. General settings 

 
Maximum of retrieved items 

The maximum number of items that will be retrieved after a search. The default is 
100 items. Setting a higher number here can impact memory usage if you also 
specify extensive search conditions. 

 

Check for required fields upon saving 

Check if all the required fields have been entered. If not, the item is not saved to the 
database and Data Crow displays a message showing which fields should be filled 
in.  
This option is enabled by default and we do not recommend turning it off because it 
could cause data inconsistencies. However, we do recommend that you define your 
own required fields (see Required field settings). 

 

Check for value uniqueness upon saving 

Data Crow will check if the item is unique before it is saved. Uniqueness is 
determined by the required field values. If the item is not unique it will not be saved 
and a message will be displayed.  
This option is enabled by default and we do not recommend turning it off. 

 

Show tool tips for tables 

Toggle the tool tips for values in the tables. 

 
 

Ask to close server on exit 

When closing the client, Data Crow will ask if the server should be closed as well.  
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Perform a blank search on startup 

Start a search without any search conditions when starting Data Crow. 

 

Show hidden fields in item form (ignore field selector setting) 

Turning it on means that fields not shown in the table are shown in the item form. In 
older versions of Data Crow, hidden fields would remain hidden throughout the whole 
application. By default this option is off. 
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6.2. Required field settings 

Required fields can be set for each module. Set the “Required y/n” value to “Yes” in the 
required fields table if a value for that field must be input. 
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6.3. HTTP Settings 

General HTTP settings can be specified here. 
  

Proxy Server port 

If you are behind a proxy server, you must specify the proxy server port number. By 
default, the port number is set to 0 (no proxy). Most proxy servers will be set to port 
“8088”.  

 

Proxy Server name 

The name of the proxy server must be specified when you are behind a proxy server. 

 

Proxy username 

If needed, input the username needed for the entered proxy server. 

 

Proxy password 

Enter the password belonging to the given username. 

 

Browser path 

Specify the browser which should be used by Data Crow when opening hyperlinks.  

By default Data Crow will try and find the default browser for the current 
environment.  

  
  

6.4. Background color 

The background color is set by moving the slider on the color panel and clicking in the 
color palette. Don’t forget to press "Save”—otherwise the selected color will not be 
saved for the next session! 
 
 

6.5. Fonts 

Select a different font or modify the current font. Changes take effect after restarting 
Data Crow. 
 
 

6.6. Table Colors 

Change the display colors, including the row selection color and the colors of even and 
odd rows. 
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7. Tools 

 
 

7.1. Software categories 

Software can be categorized via the “Software type” list box. Some categories are pre-
defined (mostly related to gaming). To add or modify categories, select the “Categories” 
button from the menu bar and enter new data or modify existing categories.  
 
 

7.2. Import 

Because Data Crow represents items that exist in the real world (like audio and software 
CDs), the application needs to make contact with these real items. The import tool 
allows you to do this. For more details, see Importing data. 
 
 

7.3. Online Search 

Update an existing or new item with information retrieved from the internet. This is 
explained in more detail in Searching the online databases. 
 
 

7.4. Expert User 

The Expert User tool includes the System Information and tools tab, and the SQL Tool 
tab.  
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8. Creating new items 

New items can be added by selecting the tab “New <item>” (where <item> refers to a 
software, music, movie, or book item, depending on the active module).  
 
By default, the table is empty (no items are present). To enter a new item, press “Add 
item”. An empty row is added to the table. You can enter the data either directly into the 
row or use the item form.  
 
 

8.1.  Creating a new item 

There are several ways to create new items: 
  
 

- Use the item wizard 

- Open the “File” menu and select “New <item>”. This will open the item form. You 
can either type all the values or use the online updating function 

- Press “Add item” in the “New <item>” tab and enter the values 

- Start the CD Import dialog (see Importing data) 

- Search an online database. (For Audio CDs, see Searching online databases 
(Audio CDs) and Importing data) 
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8.2. Using the right-click menu to create items 

The right-click menu in the “New <item>” tab offers the following options:  
 

 
 

 
Field Selector 

Opens a dialog that allows you to select the fields to be displayed. 

 
Update all 

Sets the selected field(s) in the table to the specified value(s). 

 
Open  

Opens the item in the item form. 

 
Save  

Saves the selected item(s) to the database. 

 
Remove  

Removes the selected item(s) from the table. 
 
Add 

Adds an empty row to the table 

 
Update <online database> 

Updates the selected item(s) with data from an online database such as Amazon or 
IMDb. 
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9. Item wizard  

For every module an item wizard is available. Via this wizard new items can be created. 
The wizards combine the internet search functionality and manually changing the 
information of the item. The wizard comes with help for each step and is not further 
described here. 
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10. Viewing and modifying items 

Items are displayed in a table in the main pane. One row represents one item. Right-
clicking on an item opens a sub-menu with further options. Items can be deleted, 
updated with an online database, or opened. Items can also be directly modified within 
the table. 
  
To view all items in a module, select that module and then perform a Find where all the 
search conditions are blank. The result will return all items stored under that module. 
 

10.1. Viewing & changing existing items 

To view an item already stored in the database, open the module that contains that item 
and perform a search using the Find function. 
 
An item can be opened by either double-clicking on the item or using the right-click 
menu. An item is opened in the item form. 
  

10.2. The item form 

The item form shows a single item in the database. The form allows you to create, 
update, or delete an item. To modify an item, select the values and update them. Note 
that double-clicking on a large text field opens the text in a larger window.  
 
Changes to an item can be saved by pressing the “Save” button. Pressing the “Close” 
button discards any changes (without warning!) and closes the form. To delete an item, 
press the “Delete” button.  
 
The item form consists of one or more tabs–each image belonging to an item is shown in 
a separate tab. Pictures (such as screenshots) and Children (such as, for example, with 
audio CDs) are also shown in a separate tab. Images can be deleted or replaced by 
double-clicking on the current image. A window appears where you can select a new 
image or delete the current image. 
 
Items can also be updated with data from an online database (see Searching the online 
databases).  
 

10.3. Updating data directly in the table 

Instead of opening an item in the item form, you can change, delete, or update data 
directly in the table. To edit a cell in the row, place the cursor in the cell and press F2. 
You can cycle through the rows using the arrow keys. Changes are saved by using the 
right-click menu or by pressing the “Save changes” button. 
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10.4. Using the right-click menu to edit items 

All actions in the table are available from the right-click menu. Some actions, such as 
“Open item”, can be applied to single items only, while other actions can be used on 
multiple rows. 
 

 
 
 

Field Selector 

Opens a dialog where you can select the fields to be displayed. The fields not shown 
will still be maintained. 

 

Update all 

Sets the selected field(s) in the table to the specified value(s). 

 

Open 

Opens the selected item (in the item form). 

 

Save 

Saves the selected item(s) to the database. 

 

Delete 

Deletes the selected item(s) from the database. 

 

Update <online database> 

Updates the selected item(s) with data from an online database such as Amazon or 
IMDb. 

 

Create PDF report 

Creates a report for the displayed / retrieved item(s) 
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11. Searching the Database (Find) 

Searching is carried out using the “Find” function, which is available from the toolbar. 
You can search for items using various combinations of conditions and search options to 
filter the results.  
 

The results of a search are displayed in the “<item>” tab. To clear the results from the 
table, press the “Clear” button. 

 
Note: You can only search for items in the active module. Thus, if you want to search for 
a particular movie, the Movies module must be active. 
  
 

11.1. Search conditions 

Keywords can be entered in any or all of the search fields. You can enter more than one 
value in a field by separating keywords with the ‘%’ character. For example, the search 
condition “easy%creator” will retrieve all items which contain “easy” AND “creator” (note 
that there are no spaces between the ‘%’ character and the keywords). 

 
 

11.2. Search options 

 
Comply with all search conditions 

Specify if the results must comply with all the search conditions or with any one of 
the search conditions. 

 

Example: the following search conditions have been specified: 
 

name = test, location = CD1 

 

If the “Comply” option is checked, the result will return items which contain the name 
“test” AND the location “CD1”.  

If the “Comply” option is not checked, the result will return all items which contain 
either the name “test” OR the location “CD1”. 

 



 24 

Match exact search conditions 

If this option is enabled the resulting items must comply with the exact search 
conditions. If the option is disabled the search condition is used to see if the field 
contains the value. 

 

Example: the following search condition has been specified: 
 

name = DOOM 3 

 

If this option is checked then only results with “DOOM 3” in the name field will be 
returned. If the option is unchecked then all items with “DOOM” or “3” in the name 
field will be returned. 

 

Order by 

Orders the results by the selected field.  
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12. Searching online databases  

Data Crow can save you time by retrieving information about an item from an online 
database such as Amazon, IMDb, or freedb. (For updating audio CD information online, 
see Searching online databases (Audio CDs).) 
 
The option to update a new or an existing item using an online database is available by 
using either the item form, the tool bar, the menu bar, or the right-click menu. Online 
databases can also be used to add new items to the database. 
 
There are two important settings: 
 

Overwrite existing values 

Overwrites the item with the values you choose. If you do not select this option, only 
empty fields are updated. 

 
Optimize For Broadband. 

When selected, better images are retrieved for software items. If the waiting time is 
acceptable, select this option! 

 
(The values you select will be remembered the next time you run Data Crow.) 
 
 

12.1. Searching 

When the option to update has been selected, the search form is opened. A search is 
started immediately if the name of the software or the title of a movie has been filled in. 
Otherwise, you have to start the search manually.  
  
If the result you are looking for is not shown, try using a different search condition. 
 

12.2. Update 

If the desired result is displayed, select the item and press “Update”. The selected item 
is updated with the new information. 
   
 

12.3. Add as new 

If no item was selected for updating, “add as new” is the only option available. (This 
option is also available when updating an item.) 
 
 

12.4. Stopping the search action 

To stop the current search, press “Stop”. The current search action is cancelled. When 
more then one item is selected for updating, press “Close” to stop all updates.  
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13. Searching online databases 
(Audio CDs) 

Retrieving online information for audio CDs works the same as described in the previous 
chapter with the exception that it also supports extracting information from the audio CD 
itself so that a precise online search can be performed.  
 
To get information for an audio CD, you first need to insert the audio CD in your CD 
drive. When the desired result has been found, select it and press “Add as new”. The 
Audio CD is then shown in the “new <item>” tab. It has not yet been saved to the 
database—when you are satisfied with the details, press “Save”. 
 
You might be wondering why the result is not saved directly to the database on transfer? 
We did this for two reasons: 1) the new item table is always used as a holder for new 
items; 2) the new item table has extra options that can be used before you save the 
item.  
 
Note: Audio CDs must be inserted into the primary CD drive of your machine! 
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14. Importing data 

Using the import feature you can quickly retrieve information from your CD or hard drive. 
This feature is found in the “Tools” menu under the name ‘X import’ (where ‘X’ is the 
module name). 
  

 
 

 

Directory / File 

The directory from which data will be extracted or a single file. 

 

Location Identifier 

The name of the CD or the location of the CD. 

 

Confirm each directory 

For each directory it encounters, Data Crow will ask you if the data from this directory 
should be read or not. If you answer No, the directory name itself will be registered, 
but not the files it contains. Answering Yes imports the files and sub-directories from 
this directory. 

 

Recursive directory search 

Search the specified folder and its sub folders 
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15. Expert User Tool 

The expert user tool shows system information, contains maintenance tools, and offers a 
direct connection to the database. 
 

 
 
 

15.1. System information 

The system information dialog shows how many items are in the database per module, 
the database name, and the driver that is used to connect to the database. 
 
 

15.2. Maintenance 

The maintenance tool “Compact database and shutdown” is a direct call to the HSQL 
database engine. The following information about this tool is reproduced from the HSQL 
database website: 
 
“Writes out a new .script file which contains the data for all the tables, including 
CACHED and TEXT tables. It then deletes the existing text table files and the .data file 
before rewriting them. After this, it backs up the .data file in the same way as normal 
SHUTDOWN. This operation shrinks all files to the minimum size” 
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15.3. SQL tool 

The SQL tool offers a quick and direct way to manipulate data in the database. It 
overrides all checks on data so it should be handled with care. 
 
If you’re not familiar with SQL, you’d be better off not using this tool as you might make 
unwanted changes. 
 
Creating and executing an SQL statement 
Enter an SQL statement in the “Query input” field and press “Run” to execute the 
statement. Errors will be shown if the query is incorrect (these messages are generated 
not by Data Crow but by the database engine).  
 
Previously-executed statements can be retrieved from the “Prepared SQL statements” 
list box. You will see that a couple of predefined queries are already in there. 
 
The result of a select query is shown in the “Query result” table.
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16. Block note 

The Block Note tool can be used to maintain a ‘To do’ list or write other remarks. It’s very 
straightforward!  
 
(Note that the content of the block is the same for every module). 
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17. Reporting 

The reporting tool creates PDF files based on items retrieved via a search. There are 
two types of reports; a list report and the card report. The list report is, as the name 
indicates, a listing of the items whereas the card report shows detailed information on 
each item. Below there are two examples shown. Note that all is customizable; from the 
data itself (ordering, including / excluding fields) to the way it is represented (background 
color, text color, fonts, alignment, etc). 
 
List report example 

 
 
Card report example 
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17.1. Creating a report 

Via the reporting dialog, reports can be generated. The report dialog can be started from 

the menu bar (Tools > Create Pdf Report) via the toolbar ( )  and via the right-click 
menu. The dialog offers the basic for creating the report. The advanced settings can be 
found under the “Settings” button (explained in the next paragraph). 
 

 
 

Target file 
the file to which the report will be saved. The report is saved as a PDF file. 

 
Report Type 
there are two report types, the list report and the card report. See the previous 
paragraph for examples of both types. 
 
Fields 
All fields belonging to the module are listed. Fields can be excluded from the 
report and the alignment can be set (left / center / right). 
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17.2. Settings 

Each module has its own dedicated report settings, for both report types. The settings 
are divided in 4 main groups: 
 
Text 
All settings for the field values  
  
 Create index 

Only available for Card Views. Creates an index within the PDF for easy 
reference. Adds a numbered title to each record. 

 
 Position of values 
 Show text below or beside the labels 
 

Borders 
Options: border bottom, border left, border right, border top. Check the checkbox 
to enable the border for the chosen side. The borders are shown around the 
values of the fields. 
 
Text Color 
Font / Text color 
 
Text Font 
Font for the field values / text 
 
Text Border Color 

 Color of the (activated) border(s) 
 
 Text Background Color 
 Background color for all field values 

 

Labels 
All settings for the field labels 
 

Borders 
Options: border bottom, border left, border right, border top. Check the checkbox 
to enable the border for the chosen side. The borders are shown around the 
labels. 
 
Text Color 
Font / Label color 
 
Text Label 
Font for the labels 
 
Text Border Color 

 Color of the (activated) border(s) 
 
 Text Background Color 
 Background color for all labels 
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Header 
Page header settings. The header is shown on each separate page. 
 
 Show header 
 Disable / Enable the page headers 
 
 Page header text 
 Static text, displayed in the header for each page  
 

Header Text Color 
Header text color.  
 
Header Font 
Font for the header text 

 
 Header Background Color 
 Background color for the header 
 
 
Footer 
Page footer settings. The footer is shown on each separate page. 
 
 Show page numbers in the footer 

Disable / Enable the page numbering. The page numbers are displayed in the 
footer of each page 

 
 Page footer text 

Static text, displayed in the header for each page (as <description> <page 
number>) 

 
Footer Text Color 
Footer text color.  
 
Footer Font 
Font for the footer text 

 
 Footer Background Color 
 Background color for the footer 
 
 
 
 

17.3. Printing a report 

Data Crow has no functionality to print PDF files. In order to print a PDF file find a free 
Pdf viewers suitable for the platform you are running on.
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18. Update All 

The Update All function is accessed via the right-click menu. This functionality allows 
you to quickly set selected fields within a table to a common value. The update is 
performed on screen only—you still have to save the update to the database. 
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19. Field Selector  

Here fields can be selected to be shown in the tables or made hidden. The field selector 
can be started from the right-click menu and from the settings menu. 
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20. The database (HSQL) 

For more information about the HSQL database, please visit the HSQL webpage: 
http://hsqldb.sourceforge.net/. 
  
By default, the database is called “dc”. Corresponding files called “dc.script”, “dc.data”, 
and “dc.properties” are created within the /data directory. 
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